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1 Protect data with the Secure Pro ULTRA USB 

The Secure Pro ULTRA USB is a secure USB drive that enables you to access a 
password-protected data storage area. This ASBE-encrypted data storage area secures 
your sensitive data from unauthorized access, using the MerlinSafe program. 
 
The USB “root directory” is the first, or top-most, directory in the file folder hierarchy. 
From the root directory, you can launch a program to create or enter your MerlinSafe 
password, and then access a secure area called a Secure Folder. When you drag files 
into the Secure Folder, from the program interface, these files are automatically 
protected with ASBE encryption. The ABE-encrypted files receive an appended file 
extension .ASBE to provide visual confirmation of encryption. 
 

USB  
Root Directory 

Top-most folder in 
the file directory 
hierarchy and 
includes all sub 
folders 

Contains the MerlinSafe 
program for user 
authentication and ASBE file 
encryption 

With successful 
Password entry, a 
user authenticates to 
the Secure Folder 

 

Secure Folder 

Protected area to 
ASBE-encrypt, 
decrypt from, and 
store files, folders, 
and programs 

Authenticated users can safely  
ASBE-encrypt, decrypt, 
securely delete, or store files 
and folders 

Secure Folder 
provides superior data 
protection with ASBE 
encryption 

 

2 System  

2.1 Requirements 

 Pentium CPU 

 Operating Systems: Windows 10, Windows 8, Windows 8.1, Windows 7, Windows 
Server 2012, or Windows Server 2008. 

 Access to your host computer drives 

 Available USB port 
 
The Secure Pro ULTRA USB does not require administrative rights. 

Host system must support mass USB storage. 

2.2 Recommendations 

 Graphic accelerator that supports 24-bit color depth for best quality graphics 
 

http://en.wikipedia.org/wiki/Directory_%28computing%29
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3 Authenticate to the Secure Folder 

To protect your data, we recommend that you create your password to the Secure 
Folder right away, so you can begin to use the Secure Pro ULTRA USB to protect your 
valuable data. 

3.1 Launch the MerlinSafe program 

Plug-in the Secure Pro ULTRA USB 

Insert the Secure Pro ULTRA USB into an available USB port. 
 

Access the Secure Pro ULTRA USB root directory 

The Windows Explorer window opens automatically to the “root directory” of the 
VERBATIM flash drive and all its sub folders. The VERBATIM flash drive root directory 
displays the MerlinSafe programs: 

 Windows MerlinSafe.exe, and 

 a folder: MerlinSafe_MAC.app, contains the Macintosh MerlinSafe program. 

 

The MerlinSafe Quick Start Guide for Windows, QuickStartGuide_Windows.pdf, is a 
fast-track start to help you begin to use MerlinSafe to protect your personal and financial 
data. 
 
The doc folder contains the MerlinSafe User Guide for Windows, a visual walkthrough 
of the steps and tips for using MerlinSafe. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If this window was previously closed, go to the taskbar, click to open the Start menu, and 
then double-click Computer (or My Computer). In the Windows Explorer (or File 
Explorer) window, double-click to open the drive letter assigned to your VERBATIM USB, 
“the removable USB drive.” The root directory appears in the Windows Explorer window. 

 

 

The VERBATIM USB window 
displays the root directory 

that contains: 

 MerlinSafe programs for 
Windows and 

Macintosh, 

 MerlinSafe Quick Start 
Guides, and 

 a doc folder that 
includes the MerlinSafe 

User Guides. 
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Open MerlinSafe.exe 

1) In the root directory, double-click MerlinSafe.exe to open the program. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) The Enter Password window displays. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For added security, there is a Secure Folder on the Secure Pro ULTRA USB.  
In the Enter Password window, you can create a unique password, which is 
your authentication to the Secure Folder. After you successfully enter your 
password, the Secure Folder opens. Within the protection of the Secure Folder, 
you can encrypt, organize, and store your important ASBE-encrypted files. 

 
 

 

 

Double-click 
MerlinSafe.exe to 
open the program. 
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3.2 Create a password 

Locate the Help menu 

The Help menu shows you the steps to create a password. Click the Help menu, and 
then click Create a Password.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Locate password rules 

As you begin to create a password, the password requirements are conveniently 
displayed in the Enter Password window. This is a quick reference for you. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Password rules 

display in the 

Enter 

Password 

window. 

Click Help. 

 

Click 
Create a 

Password. 
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A password to the Secure Folder requires: 

 Minimum length is 9 characters. 

 Maximum length is 127 characters. 

 At least one: 

 Digit: [0-9] 

 Lower case letter: [a-z] 

 Upper case letter: [A-Z] 

 Space or special characters: !”#$%^&’()*+,-./:;<=>?@[\]~_`{|} 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use your mouse to click the individual keys on the “virtual keyboard” as you create a 
password. For your protection, to defeat the key logger type of malware, the “physical 
keyboard” on your computer is ignored. You must use the “virtual keyboard” to create 
your password. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

“Spaces” count as 
characters in a password. 
To create one or more 
“space” characters in your 
password, use your mouse 
to click the Spacebar key. 

Tip 

 

As you click to 
create your new 

password, when 
“a password 
requirement is 
completed,” its 
text color 
changes (from 

black) to green. 

In the Create 
Password 
window, use your 
mouse to click 

keys on the 
“virtual keyboard,” 

as you create your 
password. 
 
To protect you 
against key logger 

hack attacks, you 
CANNOT create 
your password by 
using the 
(physical) 
keyboard on your 

computer. 
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Unique virtual keyboard 

For increased security, the layout of the MerlinSafe “virtual keyboard” is purposely 
different than the layout of a physical computer keyboard. MerlinSafe’s virtual keyboard 
facilitates the use of stronger, more secure passwords while making them easier to 
remember. Simply click to create your password using a familiar “pattern” on the virtual 
keyboard, so you can easily remember it. 
 

Locate the password length indicator 

As you click keys on the “virtual keyboard” to create your new password, a password 
length indicator shows you the length of your password, as you create it. 
 

 
 
 
 
 
 
 
 
 
 
 

Fulfill minimum-strength requirements 

1) When you finish clicking the specific keys on the “virtual keyboard” to create 
your password, and the minimum-strength requirements have been met, click 
Create Password. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A password 
length 
indicator 
displays the 
length of 
your 

password, as 
you create 
your 
password. 

 

Click Create 
Password. 
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2) To reenter your password, click the specific keys on the “virtual keyboard.” 
Then, click the Confirm Password button, to authenticate to the Secure 
Folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Create Password button, and the Confirm Password button, display as 

you set up a password. These buttons only show when no other password was 
previously established. 

 
3) When you receive the message: “Important! If you forget or lose your 

password you will not be able to access encrypted files. Do not store 
passwords on your computer or within emails which may be subject to 
discovery or interception,” click OK. 

 

 
 
 
 
 
 
 
 
 
 
 

 
Click OK. 

 

Click 
Confirm 
Password. 

Tip 
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The MerlinSafe Encrypt Files and Folders window 

In the Encrypt Files and Folders window, the unprotected files on your computer, 
display in the left panel. Your protected files, which are encrypted with ASBE on the 
USB, display in the Secure Folder in the right panel. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 

Getting started with MerlinSafe is complete: 

 
 
 
 
 

Remember your password.  
(Store a copy of it in a safe place, not on your computer). 

 

 
 

 

 Create a password. 

Not protected ASBE-encrypted 

Computer USB Secure Folder 

Tip 



Working with MerlinSafe  

©2016 MerlinCryption LLC. All rights reserved.  10 
 

 

4 Secure files and folders 

To manage the data between your computer and the Secure Folder, you can easily 
ASBE-encrypt and decrypt your important files and folders, with a drag and drop or a 
simple right-click. 
 

 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 

The right-click menu can help you quickly manage and secure your data. 
Using the right-click menu, you can ASBE-encrypt, decrypt, delete, 
rename, and move your personal and business files and folders. 

 
 
 
 
 
 

ASBE-Encrypt or Decrypt Data 

 

or 

Drag and Drop 

Right-click 

 

For example, this is the right-click menu to decrypt 
a file or folder: 

 

 

Not Protected 

Computer 

ASBE-Encrypted 

USB Secure Folder 

Manage Files and Folders 
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4.1 ASBE-encrypt files and folders 

Multiple-select files 

You can ASBE-encrypt or decrypt multiple files and folders at the same time. 
To select nonadjacent folders or files, select a single folder or file, and then hold down the 
Ctrl key while clicking other files or folders that you want to select. 
 

There are two simple ways to ASBE-encrypt files or folders from your computer, to the 
Secure Folder: (1) drag and drop, or (2) right-click. Choose whichever way you prefer. 

Drag and drop encrypt 

1) Drag one or more files or folders into the Secure Folder: USB - 
(Protected Files) rightmost panel. 

2) Drop your files here to automatically encrypt with ASBE. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right-click encrypt 

Another way you can encrypt files and folders is with the right-click menu. 

1) Select the files or folders you want to encrypt. 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

To encrypt, drag files 
or folders into the 

Secure Folder.  
 
The Secure Folder 

is the rightmost 
panel of the Encrypt 
Files and Folders 

window. 

 

 

Select the 
folders or 
files you 
want to 
encrypt. 
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2) Right-click the selected files or folders, and then click Encrypt. 
 
 
 
 
 
 
 
 
 
 
 

The folders and their files are automatically ASBE-encrypted, and then 
safely stored in the Secure Folder. 

 

Locate ASBE-encrypted files 

To view the contents of a folder, click the folder arrow to display the list of subfolders and 
files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the USB Secure Folder, an “.ASBE” file extension is added to encrypted files which 
indicates that the files have been ASBE-encrypted. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The “.ASBE” file extension is added to all ASBE-encrypted files. 

 

 
After you select 
the files or 
folders, right-
click, and then 

click Encrypt. 



Working with MerlinSafe  

©2016 MerlinCryption LLC. All rights reserved.  13 
 

 

Locate the source files 

When you drag and drop or right-click to encrypt files or folders, a “copy” of each file 
and folder is ASBE-encrypted. These ASBE-encrypted “copies” are protected within the 
Secure Folder on the USB, in the right panel. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The “source” files or folders, remain in the original location, in the unprotected left panel 
on the computer. As you manage the security of your confidential data, you can choose 
to keep the “source” files on your computer, or to delete them, after you have ASBE-
encrypted the “copies” and safely stored them in the Secure Folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Each source 

file or folder 
remains in 

the original 
location 

 

A “copy” of each 

source file or 

folder is ASBE-
encrypted, and is 
stored on the 
USB in the 
Secure Folder. 

ssssssss
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4.2 Delete files and folders securely 

For optimal security, you can securely erase any ASBE-encrypted file or folder in the 
Secure Folder on the USB. You can also securely erase any unprotected file or folder 
on your computer in left panel. To securely erase your data, select the files or folders 
you want to delete, and then right-click, and select Delete Securely from the menu. 
 
Delete Securely overwrites every byte five times before deleting a file so no trace 
lingers on the computer. 
 

After you have safely ASBE-encrypted specific important files and folders into the Secure 
Folder, remove or delete the “unprotected” source files and folders from your computer. 
When you need a copy of the file or folder, simply decrypt it. 

 
Delete folders 
 

1) Delete (or remove) all files contained in a folder, before you delete the 
folder. Click the folder arrow to display the contents of the folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Select all the files contained in the folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip 

 

 

Before you delete 
a folder, open the 

folder to see if it 
contains any files 
or subfolders. 
 
Click the folder 

arrow to display 
the contents of 
the folder. 

 

In the folder you 

want to delete, 
select all the files 
contained in the 
folder. 
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3) Right-click the selected files, and then click Delete Securely. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

4) When you receive the “Securely deleting a file will permanently remove 
the file” message, click Yes, if you only want to delete one file. Or, if 
you want to delete multiple files at the same time, click Yes to All. 

 
 
 
 
 
 
 
 
 
 
 

5) After the files are securely deleted, the folder is empty and ready to 
delete. Select the (empty) folder you want to delete. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click YES to All to securely 
delete multiple files at the 

same time. 

 

Select the empty 
folder. 

 

Click Delete 

Securely. 
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6) Right-click the empty folder, and then click Delete Securely. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The empty folder is securely deleted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click Delete 

Securely. 

 

The folder is 
deleted, and 
does not 

display in 
the list of 
folders. 
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4.3 Decrypt files and folders 

Decrypt files from the Secure Folder with drag and drop or use the right-click menu. 

Choose whichever method you prefer, to decrypt files or folders from the Secure 
Folder, to your computer. To decrypt, use: (1) drag and drop, or (2) right-click. 

Drag and drop decrypt 

1) Before you begin to decrypt your data, first select a destination folder. 

2) To decrypt folders or files, drag one or more files or folders into the 
Computer (Unprotected Files) leftmost panel. 

3) Drop your files or folders into the destination folder to automatically 
decrypt them. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right-click decrypt 

You can decrypt one or more files and folders with the right-click menu. 

1) Select a folder as the destination for your decrypted files and folders 
 
 
 
 
 
 
 
 
 
 
 

 

 

First, 

select a 
destination 
folder. 

Select one 
or more 
files to 
decrypt. 

Drag the 
selected files 
or folders into 

a destination 
folder in the 
leftmost 
panel. 

 

In the 

leftmost 
panel, 
select a 
destination 
folder on 
your 

computer. 

In the Secure 
Folder on the 
USB, select 
one or more 

files or folders 
to decrypt. 
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2) Right-click the selected files and folders, and then click Decrypt. 
 
 
 
 
 
 
 
 
 
 
 

The selected folder and files are decrypted, and are located in the destination folder on 
the computer. These decrypted files and folders reside with the other unprotected data 
on the computer, in the leftmost panel of the Encrypt Files and Folders window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The folder, 
and the files 
it contains, 

are 

decrypted, 
and are in 
their new 
location in 
the 
destination 
folder. 

 

Right-click, 
and then 
click 
Decrypt. 
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You can view the path of the “last selected folder” displayed in the upper area of the 
leftmost panel. The leftmost panel shows the unprotected files on the computer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The size of the free space available on the VERBATIM USB, along with the total storage 
capacity of the USB, is displayed in the lower area, under the rightmost panel in the 
Encrypt Files and Folders window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

View the path of 
the “last 
selected folder” 

displayed in the 
upper area of 
the computer 
panel on the 
leftmost side of 
the Encrypt 
Files and 

Folders 
window. 

 

The size of the free space available on the VERBATIM USB, and 
the total storage capacity of the USB, is displayed in the lower 
right corner of the Encrypt Files and Folders window. 



Working with MerlinSafe  

©2016 MerlinCryption LLC. All rights reserved.  20 
 

 

4.4 Rename a folder 

In the Encrypt Files and Folders window, using the right-click menu, you 
can rename a folder in either the leftmost computer panel, or the rightmost 
USB panel. 

1) Select the folder that you want to rename. 
 
 
 
 
 
 
 
 
 
 

2) Right-click the selected folder, and then click Rename Folder. 
 
 
 
 
 
 
 
 
 
 
 
 

3) Type the new name for the folder, and then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Select 
the 
folder 

that you 

want to 
rename. 

 

 

Right-click 

the selected 
folder, and 
then click 
Rename 
Folder. 

 

 

The 
renamed 
folder 
displays in 
the list. 

Type the new 
name for the 
folder, and 

then click 

OK. 
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4.5 Create a folder  

To help you organize your files and folders in the Encrypt Files and 
Folders window, with the right-click menu, you can create a folder on the 
computer or the USB. 

1) Before you begin to create a folder, first select a destination folder. 
 
 
 
 
 
 
 
 
 

2) Right-click the destination folder, and then click New Folder. 
 
 
 
 
 
 
 
 
 
 
 
 

3) Type the name for the new folder, and then click OK. 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

Select a 
destination 

folder. 

 

 

 

Type the 
name for the 

new folder, 
and then click 
OK. 

 

Right-click, 

and then 
click New 
Folder. 

The new 
folder is 

located in the 
destination 
folder. 
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4.6 Move files and folders 

You can move files and folders using the right-click menu, in either the 
Secure Folder on the USB, or in the leftmost panel on the computer. 

 
1) Select one or more files or folders you want to move to a different 

location. (For example, move the Taxes folder into the Finances folder.) 
 
 
 
 
 
 
 
 
 
 
 

2) Right-click the folder you want to move, and then click Move Files and 
Folders. 

 
 
 
 
 
 
 
 
 
 
 

3) In the Choose destination folder window, select a “destination 
folder,” and then click the Select Folder button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Select one or 

more folders 
or files for the 
move. 

 

 

 

Right-click the 
folder, and then 
click Move Files 
and Folders. 

 

In the 
Choose 
destination 
folder 
window, 

select the 
destination 

folder. 

Click Select 
Folder. 
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The folder, and the files it contains, is relocated to the destination folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Secure Folder timeout 

For your protection, once you have authenticated to the Secure Folder 
with your password, MerlinSafe automatically closes the Encrypt Files 
and Folders window, after ten minutes of inactivity in the Secure Folder. 
The Enter Password window displays to prevent unauthorized access to 
your ASBE-encrypted data. 

 
 

Exit MerlinSafe 

When you exit the Secure Folder, you are leaving your files and 
programs safely ASBE encrypted. Click the Exit button to close the 
Secure Folder, and then exit MerlinSafe. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click Exit to 

close the 
Secure 
Folder, and 
then exit 
MerlinSafe. 

 

The folder 

is relocated 
to the 
destination 
folder. 

Ten 
minute 
timeout 
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4.7 Enter an existing password to the Secure Folder  

Once you have established your password, the next time you open MerlinSafe, a 
Secure Sign In button displays in the Encrypt Files and Folders window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1) Click the keys on the “virtual keyboard” to enter the password that you 
previously established. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

2) To authenticate to the Secure Folder, click Secure Sign In. 

 

 

Once a password exists, 
the Secure Sign In 

button displays. 

 

Click Secure 
Sign In. 

After a password is 
established, for your 
protection, the 

password rules do not 
display in the Enter 
Password window. 

Click the 
characters on 
the “virtual 

keyboard” to 
enter your 
password. 
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4.8 Reset the password 

Locate help to reset a password 

The Help menu shows you the steps to reset your password. Click the Help menu, and 
then select Reset Password. 
 
 
 
 
 
 
 
 
 

Resetting the password deletes the existing password, and all 
the files and folders are deleted from the Secure Folder. 

 
To reset your password: 
 

1) Before you reset the password, remove all important files from the 
Secure Folder. (Quickly decrypting the files is a simple solution.) 

2) In the Enter Password window, click the File menu, and then click 
Reset Password. 

 
 
 
 
 
 

1. When you receive the “Changing the Password for the Secure Folder will 
DELETE ALL FILES in the Secure Folder” message, click Yes. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Click Help. 

To view the steps in Help, 
click Reset Password. 

CAUTION! 

 

 

Click Yes. 

Click File. 

Click Reset Password. 
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To create a password: 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 

Reenter your password to confirm and authenticate to the Secure Folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2) Click Create Password. 

Follow the password rules 
displayed in the Enter 
Password window. 

1) Click the keys on the 
“virtual keyboard” to 
create a password. 

 

4) Click Confirm Password. 

3) Reenter your password. 
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5 Safely Remove Hardware 

Before you unplug your Secure Pro ULTRA USB from the USB port of your computer, 
you have to safely remove the device. Otherwise, you risk corrupting the data on your 
USB Drive. A quick way to safely remove the USB is to use the Safely Remove 
Hardware and Eject Media button on the Taskbar. 
 
To safely remove the USB, on the Taskbar, click the Safely Remove Hardware and 
Eject Media button. 
 
 
 
 
 
 
 
 
 
 
 

 

Click the Safely Remove 
Hardware and Eject Media 
button. 
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Secure Pro ULTRA USB with MerlinSafe
®
 

Frequently Asked Questions 

 

Q1: If I forget my password, how do I resolve this? 
 

A1-1: If there are no ASBE-encrypted files currently stored in the Secure Folder 
on the VERBATIM flash drive, first, plug in the Secure Pro ULTRA USB into a 
USB port on the host computer. Next, follow the steps listed below, to reset the 
password, and then create a password to the Secure Folder. 

 Double-click the MerlinSafe.exe file in the root directory. 

 In the File menu, click Reset Password.  
(This deletes the password. If you had files stored in the Secure Folder, 
this reset also would delete those stored files.) 

 Click keys on the “virtual keyboard” to create a password. 

 Click Create Password. 

 Reenter the password, and then click Confirm Password to authenticate to 
the Secure Folder. 

 In the Encrypt Files and Folders window, you can encrypt your important 
files and safely store them in the Secure Folder. 

 
A1-2: If ASBE-encrypted files are currently stored in the Secure Folder on the 
VERBATIM flash drive, and the user forgets his or her password, the user will not 
be able to decrypt those files. 

 

 The password to the Secure Folder needs a “reset.” To protect your data, a 
reset deletes all the ASBE-encrypted files and folders stored in the Secure 
Folder. Follow the steps in A1-1 to reset the password, and then create a 
password. 

 
 

Q2: What happens if a hacker tries a “Brute Force” attack on the Secure Folder? 
 

A2: After ten “failed” password-entry attempts, MerlinSafe deletes all files in the 
Secure Folder to prevent an unauthorized access of data. 

 The password is deleted. 

 All files previously stored in the Secure Folder are permanently deleted. 

 Follow the steps in A1-1 to create a new password to the Secure Folder. 

 



Frequently Asked Questions (FAQs)  

©2016 MerlinCryption LLC. All rights reserved.  29 
 

 

Q3: If I am using MerlinSafe on the VERBATIM USB, and a Name Error message 
displays, how do I proceed? 

 

A3: A name conflict can occur. Some characters allowed in file and folder names 
on the Mac, are not allowed in file and folder names in Windows. The error 
message displays the first invalid character. 

A file or folder name in Windows cannot contain any of the following characters: 

\ / : * ? " < > | 

1) Delete the invalid character in the file or folder name. 

2) Or, change the invalid character to a valid character, in the file or folder 
name. 

 

Q4: If I see a Destination Path Is Too Long message while I am using MerlinSafe on 
the VERBATIM USB, why does this happen? 

 

A4: If a file name, and its full path, are over 256 characters long, the resulting 
ASBE-encrypted file will exceed the Windows file name length limit. 
 
The solution is: change the file name, or path, to a total length that is shorter than 
256 characters. 

 
 

Q5: How do I proceed if I see an Encrypt Failed warning while I am trying to encrypt a 
file or folder to the Secure Folder in MerlinSafe? 

 

A5: A few specific system files may trigger the Encrypt Failed warning, if the file 
is already in use by your computer, and is not currently available to MerlinSafe. 

 
Close the file that was open in another program, and then ASBE-encrypt the file 
or folder. 

 
 

Q6: If I get an Encrypt Failed or Decrypt Failed error message, what does this mean? 
 

A6-1: Windows does not allow a user to “overwrite” files that are: 

 in “protected” directories (folders), such as the root directory of the C drive 
(C:\) and other directories, or  

 designated by the operating system as “privileged” files, or 

 already in use by another program. 
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Encrypt files from “protected” folders: 

 Within the “protected” folder on the computer, select the files you 
want to encrypt. 

 To encrypt, drag the selected files, from the left panel on your 
computer, to the Secure Folder on the USB. 

ASBE-encrypted files, cannot be decrypted to a “protected” folder. 

 First, select an existing non-protected folder as the destination 
folder on your computer, or create a new folder. 

 To decrypt, drag selected files from the Secure Folder, to a non-
protected destination folder on your computer. 

 
A6-2 In the left panel of the Encrypt Files and Folders window, a read-only 
property may be set for the original source file on your computer. This source file 
will have the original name of the file. 

 First, turn off the read-only property for the source file. 

o Locate the source file on your computer. Right-click the source file, and 
click Properties. 

o On the General tab, select the Read-only check box for the Attributes 
option, and then click OK. 

 You can replace the source file, with the decrypted (copy of the source) file 
from the Secure Folder. 

o Within the Secure Folder, select the (copy of the source) file you want 
to decrypt. 

o Drag the selected file from the Secure Folder, to the computer, where 
the source file is located. 

 
A6-3: If the file is a “system” file, you need to obtain administrator rights to the 
file, before you can decrypt (overwrite) the file.  

Note: Make sure you validate that there are no adverse consequences, if you 
overwrite this specific system file. 

 
 
Q7: I save my encrypted files to a different location before I reset my password. I reset 
my password. Then, I create a password exactly the same as the previous one. 
However, I am not able to decrypt those saved files. Why does this happen? 
 

A7-1: For your protection, the ASBE encryption process is designed to ensure 
that the encryption key is different every time you establish a new password, 
even if the new password is the same as the previous one.  
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A7-2: Before you reset your password, simply decrypt your important files to a 
temporary location, while you create a new password. Then, encrypt the files with 
the new password into the ASBE-protected Secure Folder. 

 
 
Q8: When I attempt to delete a folder, and I right-click: Delete Securely, I get an alert 
that tells me that the folder is not empty. But when I open the folder and look at its 
contents, it appears empty - am I doing anything wrong? 
 

A8: A folder can appear empty, and yet there can be hidden folders or files that 
do not display. 
 

 

Hidden files are generated two different ways.  

1) In both Windows and Mac computers, a program can create hidden files 
that are unknown to the user. 

2) On a Mac, the Mac operating system creates hidden files known as 
“metafiles.” 

 

Knowledgeable IT support staff and system administrators can advise you if it is 
safe to delete a specific hidden file. 

 
The Windows and Macintosh operating systems each have a different way to 
hide a file, folder, or drive. 

Windows 

In Windows, you can either view or hide a file, folder, or drive. After you insert the 
USB, a Windows Explorer window automatically displays the drive letter 
assigned to the USB, for example: Computer / VERBATIM (E:). 

 
If you cannot view a file, folder, or drive in Windows: 

1) After you insert the VERBATIM USB, the Windows Explorer window 
opens, and then displays the drive letter assigned to the USB. 

2) On the Tools menu, click Folder Options…,  

3) Click the View tab. 

4) Click the option: Show hidden files, folders, or drives.  

Any formerly hidden files, folders, or drive letters, will now display. 
 

Macintosh 
In the Mac operating system (OS), a file or folder is hidden if its name begins with 
a period (character), for example: .init_rc. 
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To find a file or folder that is hidden on a Mac computer, you have to:  

 go “below” the (easy-to-use) graphical user interface, and then  

 access the Mac OS engine underneath, which is the (not as user-friendly) 
command line interface of Unix. 

 

All commands typed into the command line interface of Unix, are case sensitive, 
and must be entered exactly, including any “spaces” that are a part of the 
command. 

 

To access Unix and the interior of the Mac operating system, you have to access 
a program called Terminal. When you open a Terminal window, a Unix program 
automatically runs that is named: bash. This program, bash, is what is called a 
“shell” and it performs tasks like the Mac Finder. The bash program lets you 
navigate through your hard drive, and see what is inside the folders and 
documents. 

 
If you cannot view a file, folder, or drive in the Mac operating system: 

1) Click Launchpad on the Dock taskbar. 

2) Click Other. 

3) Click the Terminal app, to view the Terminal window entitled bash. 

 

Type a command in the bash window, to navigate to the Secure Folder on the 
VERBATIM USB. The command is case sensitive and includes a “space” after: 
cd. 

 
4. In the bash window, type:  

cd /Volumes/VERBATIM/System_DoNotEnter/SecureFolder1  

Then, press Return. 

 

The next step in the bash window, is to navigate to the sub-folder you were 
working in, when you received the error message. 

 

First, type: cd (and then press the Spacebar). When you type the name of the 
sub-folder, accurately follow the capitalization of your sub-folder name, exactly 
as you have already named it.  

For example: cd Finances. 
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5. Type: cd (the name of your sub-folder), and then press Return. 

In this example, Finances is the sub-folder, and the sub-folder name is 
typed and capitalized exactly as the original sub-folder name. 

 

The command: ls –a, generates a list of all the files and folders, including 
hidden files, folders, and shortcut links. This command begins with a 

lower case L: ls –a. Remember to type the “space” in the middle of this 
command. 

 

6. Type: ls –a 

Then, press Return.  

Any previously hidden files or folders, will now display, for example: .init_rc.  

This (previously) hidden file, .init_rc, has a file name that begins with a 
period. 

 

The command: ls –a, generates and displays a list of files and folders 
(including any hidden files and folders). 

.. (Two dots) indicate a parent folder. 

. (One dot) indicates the current folder. 

Even if the folder is completely empty, a set (one and two dots) always 
displays. 

 

Macintosh and Windows 
If you use the Secure Pro ULTRA USB on both a Mac and a Windows computer, 
there may be Mac “metafiles” hidden in a folder. 

 
 A Mac computer generates metafiles. A metafile contains information 

about a file or folder for internal use by the Mac operating system. The 
metafile name begins with a period, underscore, for example: ._(followed 
by the associated name of the file or folder). Since a metafile name begins 
with a period, metafiles are hidden. 

 
 In Windows, if you attempt to delete a file or folder in MerlinSafe, that was 

originally created on a Mac, the associated metafile may still be present 
but not visible, because a metafile is hidden and does not display. 

 
 It is safe to delete a metafile, because Windows does not use them, and 

the Mac automatically recreates them, if needed. 
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Q9: If I copy all the files and folders, and the MerlinSafe program, from the Secure Pro 
ULTRA USB, to a different computer hard drive, external hard drive, or another USB, for 
a backup, the MerlinSafe program does not run. Why does this happen? 
 

A9: For your protection, your version of the MerlinSafe program only runs on the 
specific VERBATIM USB you have purchased.   

 


